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ABSTRACT 

 
Technical drawing training based on ISO standards using SolidWorks is a strategic step to enhance the 

competencies of vocational high school (SMK) teachers, particularly in aligning the learning process with 

industrial needs. This community service activity aimed to provide practical knowledge and skills to SMK 

Muhammadiyah teachers in Banyumas Regency regarding internationally standardized technical drawing (ISO 

128, ISO 5456, ISO 7200) and its implementation through parametric Computer-Aided Design (CAD) software, 

namely SolidWorks. The training methods included lectures, hands-on practice, group discussions, pre-tests, and 

post-tests. The pre-test results showed that the participants' average score was only 47.5, indicating a low level 

of understanding of technical drawing standards and the use of SolidWorks. However, after the training, the 

average score increased significantly to 79.6, reflecting a 67.5% improvement. These findings demonstrate that 

training based on hands-on practice and case studies can effectively enhance teachers' technical competencies. 

This program also strengthens the role of teachers as agents of change in vocational education based on Industry 

4.0 technology. It is hoped that this activity will be followed by advanced training sessions, such as motion 

simulation and stress analysis using CAD. 

 

Keywords: Technical Drawing; CAD Training; SolidWorks; Muhammadiyah Vocational Schools; 

ISO Standards 

 

ABSTRAK 

Pelatihan gambar teknik berbasis standar ISO menggunakan SolidWorks merupakan langkah strategis untuk 

meningkatkan kompetensi guru Sekolah Menengah Kejuruan (SMK), khususnya dalam menyesuaikan 

pembelajaran dengan kebutuhan dunia industri. Kegiatan pengabdian ini bertujuan memberikan pemahaman dan 

keterampilan praktis kepada guru-guru SMK Muhammadiyah di Kabupaten Banyumas mengenai gambar teknik 

berstandar internasional (ISO 128, ISO 5456, ISO 7200) serta penerapannya melalui perangkat lunak Computer-

Aided Design (CAD) parametrik, yaitu SolidWorks. Metode pelatihan meliputi ceramah, praktik langsung, diskusi 

kelompok, pretest, dan posttest. Hasil pretest menunjukkan bahwa rata-rata nilai peserta hanya mencapai 47,5, 

mengindikasikan masih rendahnya pemahaman terhadap standar gambar teknik dan penggunaan SolidWorks. 
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Namun setelah pelatihan, nilai rata-rata meningkat signifikan menjadi 79,6, dengan peningkatan sebesar 67,5%. 

Temuan ini membuktikan bahwa pelatihan berbasis praktik langsung dan studi kasus mampu meningkatkan 

kompetensi teknis guru secara efektif. Pelatihan ini juga memperkuat peran guru sebagai agen pembaharu dalam 

pendidikan vokasi berbasis teknologi industri 4.0. Kegiatan ini diharapkan dapat dilanjutkan dengan pelatihan 

lanjutan seperti simulasi gerak dan analisis tegangan berbasis CAD.  

 

Kata kunci : Gambar Teknik; Pelatihan CAD; SolidWorks; SMK Muhammadiyah; Standar ISO

1. PENDAHULUAN 

Gambar teknik merupakan bahasa universal dalam bidang rekayasa, yang menyampaikan informasi 

penting mengenai bentuk, ukuran, toleransi, dan detail teknis suatu produk atau komponen. Gambar ini 

tidak hanya menjadi alat bantu visual, tetapi juga berfungsi sebagai sarana komunikasi utama antara 

perancang, teknisi, dan pelaksana di lapangan (Zainul & Nugraha, 2018). Untuk menjamin keseragaman 

interpretasi, gambar teknik harus mengikuti standar internasional yang diakui secara luas, seperti standar 

dari International Organization for Standardization (ISO). Standar ini memberikan pedoman yang baku 

mengenai garis, simbol, proyeksi, dan etiket gambar, sehingga meminimalkan risiko kesalahan dalam 

proses manufaktur dan perakitan (Górski et al., 2019). 

Dalam konteks pendidikan kejuruan, terutama di Sekolah Menengah Kejuruan (SMK), penguasaan 

gambar teknik berstandar ISO menjadi kompetensi dasar yang wajib dimiliki oleh peserta didik maupun 

guru. Pendidikan vokasional dirancang untuk menghasilkan lulusan yang siap kerja dan mampu 

bersaing di industri modern. Oleh karena itu, kurikulum harus disusun dengan mempertimbangkan 

kebutuhan dunia usaha dan dunia industri (DUDI), termasuk dalam hal penggunaan perangkat lunak 

Computer-Aided Design (CAD) yang banyak diadopsi oleh industri, seperti SolidWorks (Pradana & 

Ekawati, 2022). 

SolidWorks merupakan salah satu software CAD berbasis parametrik yang mendukung pemodelan 

3D, perakitan komponen (assembly), serta pembuatan gambar kerja 2D yang sesuai standar ISO. 

Penggunaan SolidWorks dalam pembelajaran dapat memberikan pengalaman langsung kepada peserta 

didik mengenai proses perancangan produk yang mendekati praktik di dunia industri (Afnison & Alwi, 

2020). Menurut hasil penelitian Geng et al. (2020), integrasi perangkat lunak CAD dalam proses 

pendidikan teknik mampu meningkatkan kemampuan spasial, kreativitas desain, serta pemahaman 

siswa terhadap fungsi dan proses kerja suatu sistem mekanik. 

Namun, berdasarkan hasil observasi awal dan wawancara dengan guru-guru Teknik Pemesinan di 

beberapa SMK Muhammadiyah di Kabupaten Banyumas, ditemukan bahwa penguasaan guru terhadap 

gambar teknik berstandar ISO maupun penggunaan SolidWorks masih terbatas. Kurangnya pelatihan 

lanjutan, keterbatasan sarana prasarana, serta minimnya kolaborasi dengan perguruan tinggi menjadi 

faktor utama yang menghambat peningkatan kompetensi guru (Wahyudi & Wibowo, 2020). Padahal, 

guru merupakan aktor kunci dalam implementasi kurikulum berbasis industri, dan perannya sangat 

strategis dalam mentransformasikan materi pembelajaran menjadi lebih relevan dan aplikatif. 

Keterbatasan tersebut tidak hanya berdampak pada rendahnya kualitas pengajaran gambar teknik, 

tetapi juga berisiko menurunkan kesiapan siswa menghadapi tuntutan kerja di industri manufaktur. Oleh 

karena itu, perlu diselenggarakan pelatihan sistematis yang tidak hanya menitikberatkan pada 

penguasaan teknis aplikasi CAD seperti SolidWorks, tetapi juga pada pemahaman mendalam terhadap 

filosofi, prinsip, dan aturan dalam gambar teknik berstandar ISO. Pelatihan semacam ini sejalan dengan 

pendekatan upskilling bagi guru vokasi, yang telah terbukti meningkatkan kompetensi pedagogis dan 

profesional tenaga pendidik (Duran & Garcia, 2020). 

Kegiatan pelatihan ini diharapkan mampu menjembatani kesenjangan antara dunia pendidikan dan 

dunia industri, serta mendorong guru-guru SMK Muhammadiyah di Kabupaten Banyumas untuk 

menjadi agen pembaruan dalam pembelajaran gambar teknik berbasis standar internasional 
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2. METODE PELAKSANAAN KEGIATAN 

Pelatihan ini melibatkan 12 guru dari lima SMK Muhammadiyah di Kabupaten Banyumas dan berlangsung 

selama tiga hari. Pelatihan ini difokuskan pada peningkatan pemahaman dan keterampilan guru dalam 

menggambar teknik sesuai standar ISO menggunakan perangkat lunak SolidWorks. Metode pelatihan didesain 

secara sistematis, terdiri dari evaluasi awal, pemberian materi teori, praktik langsung, dan evaluasi akhir. 

2.1. Pretest 

Pretest digunakan sebagai alat ukur awal untuk memetakan tingkat pengetahuan dan keterampilan peserta 

dalam bidang gambar teknik serta penggunaan perangkat lunak SolidWorks. Pretest terdiri dari soal pilihan ganda, 

esai, dan tugas menggambar teknik yang mengacu pada standar ISO. Hasil pretest akan menjadi acuan dalam 

menyesuaikan materi dan metode pembelajaran selama pelatihan agar efektif dan sesuai dengan kebutuhan 

peserta. 

Metode pretest sejalan dengan praktik evaluasi kompetensi dalam pelatihan teknis sebagaimana disarankan 

oleh Chen et al. (2020) yang menekankan pentingnya asesmen awal untuk menentukan fokus pelatihan yang tepat  

2.2. Pelatihan Standar Gambar Teknik 

Sesi ini merupakan pembekalan teori mengenai standar internasional dalam gambar teknik, khususnya standar 

ISO yang berlaku. Materi pelatihan mencakup pembahasan standar ukuran dan orientasi kertas (ISO 5457), format 

etiket gambar atau title block (ISO 7200), aturan penulisan huruf (ISO 3098-5), pengaturan skala gambar (ISO 

5455), teknik proyeksi (ISO 5456), serta standar jenis garis (ISO 128) dan pemberian dimensi (ISO 129). Aspek 

toleransi geometrik juga disampaikan mengacu pada ISO 286-1. 

Pentingnya pemahaman standar ISO dalam gambar teknik ini juga ditekankan dalam studi oleh Lee dan Park 

(2018), yang menunjukkan bahwa standar internasional meningkatkan akurasi dan komunikasi teknis 

antarprofesional . 

2.3.  Pelatihan Pembuatan Model 3D 

Pada tahap ini, peserta dikenalkan pada antarmuka dan fungsi dasar perangkat lunak SolidWorks, khususnya 

dalam membuat sketsa dua dimensi (2D sketch). Pelatihan difokuskan pada pengenalan tools dasar seperti 

pembuatan garis, lingkaran, persegi panjang, elips, serta fitur editing seperti trim, extend, dan mirror. 

Metode pembelajaran menggunakan demonstrasi langsung di komputer dengan bimbingan instruktur, diikuti 

latihan mandiri oleh peserta. Hal ini sesuai dengan temuan dari Mustafa dan Ali (2019) yang menegaskan bahwa 

metode hands-on berbasis software CAD efektif dalam meningkatkan kemampuan desain teknik. 

2.4. Pelatihan Pembuatan Gambar 3D (Part dan Assembly)  

Sesi ini mengajarkan peserta untuk mengkonversi model 3D yang telah dibuat menjadi gambar kerja teknik 

dua dimensi dengan standar ISO. Materi meliputi pengaturan ukuran kertas, pembuatan tampilan proyeksi, 

penambahan dimensi, garis bantu, section view, dan fitur lain yang diperlukan dalam gambar teknik. 

Pentingnya gambar kerja 2D sebagai dokumen teknis yang akurat telah dijelaskan oleh Zhang et al. (2017), 

yang menekankan penerapan standar ISO dalam gambar kerja sebagai alat komunikasi yang vital dalam 

manufaktur. 

2.5.  Pelatihan Pembuatan Gambar Kerja (Drawing) 

Sesi ini difokuskan pada transformasi model 3D menjadi gambar kerja 2D yang siap digunakan dalam proses 

manufaktur. Peserta dilatih membuat multiview (top, front, isometric), section view, dimensioning, dan menyusun 

title block sesuai ISO 7200. Drawing adalah media komunikasi utama dalam rekayasa dan sangat krusial untuk 

memastikan spesifikasi teknis dipahami dengan tepat oleh semua pihak (Kim & Lee, 2018). Peserta juga 

diperkenalkan pada Bill of Materials (BOM) dan fitur detail view yang umum digunakan dalam dokumentasi 

teknik profesional. 

2.6. Post-test dan Evaluasi 

Evaluasi dilakukan dengan post-test yang menggunakan format serupa dengan pretest untuk mengukur 

peningkatan kompetensi. Menurut studi oleh Khan et al. (2017), pemberian post-test sangat efektif dalam menilai 

pencapaian pembelajaran teknis dalam pelatihan jangka pendek. Selain itu, kuesioner kepuasan peserta disebarkan 

untuk mengidentifikasi persepsi terhadap efektivitas materi dan fasilitator. Hasil evaluasi menunjukkan 

peningkatan signifikan dalam kemampuan peserta serta kepuasan terhadap pelatihan, menunjukkan bahwa 

pendekatan yang digunakan sudah sesuai dengan kebutuhan pembelajaran orang dewasa (adult learning).  
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3. HASIL KEGIATAN DAN PEMBAHASAN (Kapital) 

3.1.   Pembukaan dan Pengajian 

Kegiatan pelatihan secara resmi dibuka oleh Kepala Program Studi Teknik Mesin Universitas Muhammadiyah 

Purwokerto. Dalam sambutannya, beliau menyampaikan pentingnya penguatan kompetensi guru Sekolah 

Menengah Kejuruan (SMK) dalam bidang gambar teknik berbasis standar internasional, khususnya ISO 5457, 

guna menunjang proses pembelajaran yang relevan dengan perkembangan industri saat ini. Beliau juga 

menekankan bahwa kegiatan ini merupakan wujud nyata dari sinergi antara institusi pendidikan tinggi dan sekolah 

kejuruan dalam membangun sumber daya manusia yang unggul Sebagai ciri khas kegiatan berbasis nilai-nilai 

Muhammadiyah, acara pembukaan pelatihan juga diisi dengan sesi tausiyah dan kajian keislaman. Kajian ini 

bertujuan untuk memperkuat ruhiyah dan ukhuwah antar lembaga Muhammadiyah, serta membangun semangat 

kolaborasi yang berlandaskan nilai-nilai Islam. Tausiyah disampaikan oleh tokoh Muhammadiyah setempat, 

dengan pesan-pesan motivasi dan pengingat pentingnya ilmu serta kontribusi nyata dalam pengembangan 

masyarakat. 

3.2. Pretest 
Sesi pertama dalam pelatihan ini dimulai dengan pretest guna mengukur kemampuan awal para peserta guru-

guru dari berbagai SMK Muhammadiyah se-Kabupaten Banyumas terkait pemahaman mereka terhadap gambar 

teknik dan penguasaan perangkat lunak SolidWorks. Tes ini terdiri dari soal pilihan ganda dan esai yang mencakup 

aspek teori dasar gambar teknik, standar ISO, serta praktik sederhana membuat gambar teknik. Pelaksanaan pretest 

dilakukan secara langsung di Laboratorium Desain, Teknik Mesin Universitas Muhammadiyah Purwokerto, 

yang menjadi lokasi utama pelatihan. 

Hasil pretest menunjukkan bahwa sebagian besar peserta belum memiliki pengalaman dalam menggunakan 

software CAD berbasis parametrik seperti SolidWorks dan belum memahami secara sistematis penerapan standar 

gambar teknik ISO. Kondisi ini mengindikasikan adanya kesenjangan kompetensi yang perlu segera ditingkatkan, 

agar para guru mampu memberikan pembelajaran yang sesuai dengan kebutuhan industri dan teknologi terkini di 

lingkungan SMK. 

3.3.Pelatihan Standar Gambar Teknik 
Sesi ini bertujuan untuk memperkenalkan dan memperkuat pemahaman peserta mengenai standar gambar 

teknik ISO yang berlaku secara internasional. Materi disampaikan melalui ceramah interaktif, studi kasus, dan 

diskusi kelompok kecil. Para peserta diperkenalkan dengan konsep-konsep penting seperti tata letak gambar, garis 

dan simbol teknik (ISO 128), sistem ukuran dan toleransi (ISO 286), serta metode proyeksi pandangan (ISO 5456). 

Penyampaian dilakukan dengan menampilkan contoh nyata gambar teknik industri sebagai perbandingan. 

Diskusi berlangsung aktif, mengingat banyak guru sebelumnya hanya menggunakan standar konvensional 

atau lokal dalam pembelajaran. Pelatihan ini membantu peserta menyadari pentingnya konsistensi dan kejelasan 

dalam penyajian gambar teknik, serta bagaimana penerapan standar ISO akan memudahkan komunikasi teknik 

dalam konteks kerja nyata di dunia industri. Materi ini menjadi dasar yang kuat sebelum peserta diajak masuk ke 

penggunaan perangkat lunak SolidWorks. 

3.4.Pelatihan Sketching Menggunakan SolidWorks 
Pada sesi ini, peserta mulai mengenal antarmuka pengguna SolidWorks dan memahami cara membuat sketsa 

2D sebagai fondasi awal desain 3D. Dengan bimbingan langsung di Laboratorium Desain, para guru 

mempraktikkan penggunaan tools dasar seperti line, circle, smart dimension, dan trim. Tujuan dari sesi ini adalah 

membangun pemahaman awal tentang pembuatan sketsa parametrik dan bagaimana sketsa tersebut akan 

digunakan dalam proses pemodelan tiga dimensi. 

Peserta diberi latihan menggambar objek sederhana hingga geometris kompleks yang menyerupai bagian 

komponen mesin. Tantangan utama bagi peserta adalah beradaptasi dengan konsep kerja parametrik dan 

constraint-based modeling, yang selama ini belum banyak digunakan dalam pengajaran di sekolah. Namun dengan 

pendampingan intensif, peserta berhasil menyelesaikan latihan dengan baik dan mulai memahami pentingnya 

sketsa sebagai dasar desain teknik modern. 
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Gambar 1. Pelatihan Sketching Menggunakan SolidWorks 

3.5.  Pelatihan Pembuatan Gambar 3D (Part dan Assembly) 

Setelah memahami konsep dasar pembuatan sketsa 2D, peserta melanjutkan pelatihan ke tahap pemodelan 

tiga dimensi (3D) dari komponen mesin menggunakan perangkat lunak SolidWorks. Materi diawali dengan 

pengenalan fitur-fitur dasar seperti extrude, revolve, cut, dan fillet, yang merupakan fondasi dalam membentuk 

geometri part 3D. Dalam sesi ini, peserta diminta membuat lima komponen penyusun dari satu sistem mekanik 

yaitu knuckle joint. Proses ini dilakukan secara bertahap, dimulai dari pembuatan part yang sederhana menuju 

bentuk part yang lebih kompleks, sambil memperkenalkan prinsip parametrik lanjutan seperti pengaturan planes 

dan penggunaan reference geometry. 

Setelah semua part selesai dibuat, pelatihan dilanjutkan dengan sesi perakitan digital (assembly). Peserta 

diajarkan untuk menyatukan antarbagian menggunakan fitur Mate, yang memungkinkan penyusunan part 

berdasarkan hubungan geometris sebenarnya sesuai prinsip kerja mekanik. Langkah ini membangun pemahaman 

peserta terhadap fungsi tiap komponen dalam sistem, serta bagaimana interaksi antarpart dapat disimulasikan 

dalam lingkungan CAD. 

Sebagai bagian akhir dari sesi assembly, peserta diperkenalkan pada fitur Exploded View untuk membantu 

memahami struktur komponen secara lebih visual dan teknis. Adapun langkah-langkah eksploded view yang 

diajarkan adalah sebagai berikut: 

 

Tabel 1. Exploded view 

 
 

1. Klik menu Assembly > Exploded View. 

Setelah diklik, akan muncul panel 

eksploded view di sisi kanan layar 

2. Peserta memilih salah satu part dari 

assembly. Setelah diklik, muncul sumbu tiga 

arah (X, Y, Z) yang memungkinkan part 

digeser menjauhi posisi semula untuk 

memperlihatkan posisinya secara terpisah 

(explode) 

 

3. Langkah ini diulangi untuk setiap part 

hingga seluruh assembly ditampilkan dalam 

bentuk explode view yang rapi dan jelas. 

Tampilan ini sangat bermanfaat untuk 

dokumentasi teknis dan memahami susunan 

serta fungsi dari masing-masing komponen 

Di akhir sesi ini, setiap peserta tidak hanya berhasil membuat dan merakit satu model knuckle joint secara 

digital, tetapi juga menyajikannya dalam tampilan eksploded view yang profesional, memperkaya keterampilan 

dalam menyusun dokumentasi teknis komponen mesin secara sistematis. 

3.6. Pelatihan Pembuatan Gambar Kerja (Drawing) 
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etelah peserta menyelesaikan tahap pemodelan part dan perakitan komponen (assembly), pelatihan 

dilanjutkan ke sesi penting berikutnya, yaitu pembuatan gambar kerja (drawing). Sesi ini bertujuan mengubah 

model 3D menjadi gambar 2D yang siap digunakan sebagai acuan dalam proses manufaktur di bengkel kerja atau 

industri. Penyusunan gambar kerja mengikuti standar ISO, baik dalam format tampilan, pemberian dimensi, 

toleransi geometrik, maupun etiket gambar. 

Adapun langkah-langkah pembuatan drawing yang dipraktikkan peserta adalah sebagai berikut: 

 

Tabel 2. Drawing 

 

 
1. Membuat Drawing Baru 

Klik File > Make Drawing from 

Part/Assembly. 

2. Pilih Ukuran Kertas 

Pilih A4 - Landscape, lalu klik OK. 

  
3. Masukkan Tampilan Isometrik 

Tarik tampilan isometrik ke dalam lembar 

kerja. 

4. Atur Tampilan dan Skala 

Ubah tampilan menjadi Shaded with 

Edges, dan skala menjadi 1:2. 

  
5. Tambahkan Tabel BOM 

Klik Annotation > Table > Bill 

of Materials, lalu klik gambar untuk 

menghubungkan. Klik OK. 

6. Edit Tabel Jika Perlu 

Klik kanan pada tabel untuk mengubah isi 

BOM. 
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7. Masukkan Tampilan Atas dan Kanan 

Gunakan Model View untuk menambah 

pandangan atas dan kanan. 

 

8. Buat Alternative Position View 

Klik kanan pada tampilan kanan, pilih 
Drawing View > Alternative 

Position. Tekan Enter, geser posisi 

sesuai kebutuhan, lalu tekan Enter lagi. 

 

Sesi ini membantu peserta memahami alur lengkap dari desain digital hingga dokumentasi teknis. Gambar kerja 

yang dihasilkan mencakup multiple views, dimensi, toleransi, dan etiket gambar sesuai ISO. 

3.7. Post-Test dan Evaluasi 
Untuk mengukur efektivitas pelatihan, dilakukan post-test setelah seluruh materi disampaikan. Hasilnya 

menunjukkan peningkatan signifikan dibandingkan pretest. Nilai rata-rata peserta naik dari 47,5% menjadi 79,6% 

atau meningkat sebesar 67,5%. Hal ini mencerminkan bahwa metode pelatihan berbasis praktik langsung dengan 

pendekatan studi kasus berhasil meningkatkan pemahaman dan keterampilan peserta secara substansial, terutama 

dalam menerapkan standar gambar teknik ISO dan penggunaan SolidWorks dalam konteks pembelajaran vokasi. 

Selain post-test, dilakukan pula evaluasi kepuasan peserta melalui angket. Mayoritas guru menyatakan puas 

terhadap materi, metode, dan penyampaian oleh fasilitator. Mereka juga mengungkapkan bahwa pelatihan seperti 

ini sangat relevan dan dibutuhkan secara berkala untuk mendukung kurikulum dan kesiapan siswa menghadapi 

dunia industri. Banyak peserta juga memberikan masukan agar pelatihan selanjutnya mencakup topik lanjutan 

seperti simulasi gerak (motion simulation) dan analisis tegangan (stress analysis) dalam SolidWorks. 

Secara keseluruhan, pelatihan yang diselenggarakan di Laboratorium Desain Teknik Mesin Universitas 

Muhammadiyah Purwokerto ini berjalan lancar dan efektif, serta mendapat tanggapan positif dari peserta maupun 

pihak sekolah. Kegiatan ini diharapkan menjadi model berkelanjutan dalam peningkatan kompetensi guru SMK 

di bidang teknologi berbasis industri 4.0. 

 
Gambar 2. Perbandingan nilai antara pretest dan post test. 
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Setelah pelaksanaan post-test, dilakukan pula evaluasi kepuasan peserta melalui pengisian kuesioner. Hasil 

evaluasi menunjukkan bahwa sebagian besar peserta menyatakan puas terhadap pelaksanaan pelatihan, baik dari 

segi kesesuaian materi dengan kebutuhan, perencanaan, solusi yang diberikan, maupun manfaat yang 

dirasakan. 

Namun demikian, beberapa peserta memberikan masukan agar durasi pelatihan ditambah. Selama tiga hari 

pelatihan dirasa belum cukup untuk mendalami materi secara menyeluruh, karena sebagian besar masih berada 

pada level dasar, belum sampai pada aplikasi gambar teknik yang kompleks. Oleh karena itu, peserta berharap 

diadakan pelatihan lanjutan yang mencakup topik-topik seperti simulasi gerak (motion simulation) dan analisis 

tegangan (stress analysis) menggunakan SolidWorks. 

Kegiatan pelatihan diakhiri dengan seremoni penutupan, serta sesi refleksi singkat dari peserta dan fasilitator 
yang menekankan pentingnya kesinambungan pelatihan teknis ini dalam menunjang pembelajaran SMK yang 
adaptif terhadap kebutuhan industri 4.0 

SIMPULAN 

Pelatihan gambar teknik berbasis standar ISO menggunakan SolidWorks yang diberikan kepada 

guru-guru SMK Muhammadiyah di Kabupaten Banyumas terbukti efektif dalam meningkatkan 

kompetensi teknis peserta. Hasil evaluasi menunjukkan adanya peningkatan signifikan pada nilai post-

test dibandingkan dengan pretest, yaitu dari rata-rata 47,5 menjadi 79,6, yang berarti terjadi peningkatan 

sebesar 67,5%. Pelatihan ini berhasil memberikan pemahaman konseptual dan keterampilan praktis 

dalam penerapan standar ISO 128, ISO 5456, dan ISO 7200, serta penggunaan perangkat lunak CAD 

parametrik (SolidWorks). Selain meningkatkan kemampuan menggambar teknik secara profesional, 

kegiatan ini juga memperkuat peran guru sebagai agen transformasi dalam pendidikan vokasi berbasis 

industri 4.0. 

SARAN 

Diperlukan program lanjutan yang lebih mendalam, seperti pelatihan simulasi gerak (motion 

analysis), analisis tegangan (stress analysis), dan pembuatan desain berbasis perakitan kompleks 

(advanced assembly) untuk memperluas kompetensi guru dalam bidang teknik mesin berbasis CAD. 

Selain itu, SMK Muhammadiyah perlu memperkuat fasilitas laboratorium komputer dan perangkat 

lunak CAD, serta membangun kemitraan yang berkelanjutan dengan perguruan tinggi guna mendukung 

peningkatan kapasitas guru secara berkelanjutan. Hasil pelatihan ini juga sebaiknya diintegrasikan ke 

dalam proses pembelajaran di SMK dengan memperbarui kurikulum agar lebih selaras dengan 

kebutuhan industri, khususnya dalam aspek desain teknik dan pemanfaatan perangkat lunak CAD 

standar industri. Kegiatan pelatihan serupa perlu direplikasi di SMK lain di wilayah Kabupaten 

Banyumas atau daerah lain sebagai langkah strategis untuk menyelaraskan kompetensi guru dengan 

perkembangan teknologi dan tuntutan dunia kerja. 
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